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Pro Tools 8.0.3 Release Notes 
for Pro Tools HD, LE, M­Powered, and M­Powered Essential Systems  
December 15, 2009 
 
Pro Tools 8.0.3 is primarily a maintenance release for Pro Tools 8.0.x owners. The 
following is a select list of fixes in Pro Tools 8.0.3: 
 

Editing 
 
Edit/Tool Mode Keyboard Locking (Item #88083) 
OS/Platform: All  
Area: Editing 
In previous versions of Pro Tools, it was easy to accidentally hit the same keyboard shortcut 
twice and inadvertently switch between tool types. You can now check Edit/Tool Mode Keyboard 
Lock in the Options menu to avoid this. When checked, this option locks the ability to change tool 
types (i.e. change from the normal trimmer to the scrub trimmer) via keyboard shortcuts, 
however tool types can still be changed via the mouse or right-clicking. When checked, you can 
still switch between tools (i.e. switch from the Grabber to the Trimmer) via keyboard shortcut. 
This option affects the following tools and edit-modes: Grid, Zoom, Trim, Grabber, and Pencil. 
 
Automation doesn't follow when creating a fade with the smart tool (Item #118711) 
OS/Platform: All 
Area: Editing, Automation 
When creating a fade with the smart tool on a region with automation, the automation value 
would not follow the fade. 
 
Exiting the Start/End/Length fields using "/" (the forward slash key from the 
numeric keypad) caused the entered value to be ignored (Item #118727) 
OS/Platform: All  
Area: Editing/Conform 
Resolved an issue in which using the "/" key (forward slash key from the numeric keypad) to exit 
the Start/End/Length fields after entering a value would cause the entered value to be ignored. 
This broke the workflow with several 3rd party conform applications. 
 
Trimming plug-in automation down beneath a track's playlist border could cause 
inverted results (Item #118841) 
OS/Platform: All 
Area: Editing, Automation 
Resolved an issue in which trimming a selection containing plug-in automation down beneath a 
track's playlist border could cause the resulting automation to be inverted and at the wrong 
values. 
 
Time stamp values incorrect when spotting a file that has been dragged from the 
desktop (Item #119744) 
OS/Platform: All 
Area: Editing 
When dragging a file from the desktop in Spot mode, the Original Time Stamp and User Time 
Stamp values were displayed incorrectly in the Spot dialog. This has been resolved. 
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Destructive Punch 
 
Pro Tools crashes after recording in Destructive Punch record mode (Item #116765) 
OS/Platform: All/HD 
Area: Destructive Punch Recording 
In certain situations if destructive punch recording, Pro Tools will crash if the user saves and 
closes a session within a few seconds of stopping recording. 
 
Using Destructive Punch mode to record into a selection records through the post-roll 
(Item #120656) 
OS/Platform: All/HD 
Area: Destructive Punch 
Destructive Punch would incorrectly record through the post-roll, if post-roll was enabled. This 
has been resolved. 
 
Pro Tools doesn't record in Destructive Punch if the hard drive is approaching full 
capacity  (Item #119953) 
OS/Platform: All/HD 
Area: Destructive Punch 
Resolved an issue in which Pro Tools would not record in Destructive Punch mode if the hard 
drive had less than 5.5 GB available (at 48kHz). No error was posted. 

 

Satellite 
 
Scrubbing with satellite tracks (Item #91640) 
OS/Platform: All/HD, LE 
Area: Video Satellite 
In previous versions of Pro Tools the Video Window would appear during scrubbing (if the "Scrub 
In Video Window" is checked), even when the only video track in the session was a Satellite 
track, and therefore no actual video media is present. This behavior has now been changed so 
that if the session only contains a satellite track, the video window will not appear during 
scrubbing. 
 
Importing video as a satellite track always tries to link to media (Item #104098) 
OS/Platform: Mac, Windows/HD 
Area: Video Satellite 
Previously when opening an AAF that contains a video track and choosing to import to a Satellite 
track, Pro Tools would still attempt to link to the underlying video media. When working from 
ISIS workspaces, this often caused Pro Tools' responsiveness to slow down dramatically. This 
issue has been resolved - Pro Tools no longer attempts to reference any media contained on 
Satellite tracks. 
 
Can’t reconnect Video Satellite after disabling satellite mode in Media Composer 
(Item #115036) 
OS/Platform: All/HD 
Area: Video Satellite 
When in Satellite Mode, if while connected Video Satellite was disabled in Media Composer, it 
would not be possible to reconnect without changing to a different TCP/UDP port in both Media 
Composer and Pro Tools. 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On Satellite track yellow highlight does not update after trying to make a change 
(Item #116134) 
OS/Platform: All/HD 
Area: UI 
In some circumstances, when editing a satellite video track in Pro Tools the yellow lines around 
the region being edited would not update after the edit is finished and a different selection is 
made. 
 
Incorrect video reference rates do not match error with Video Satellite (Item 
#116517) 
OS/Platform: All/HD 
Area: Video Satellite 
If Media Composer and Pro Tools were locked to different multiples of the same sync (e.g. 25fps 
and 1080i/50), Media Composer would throw a false error saying that the rates do not match and 
the systems will play out of sync. 
 
Video Satellite did not post errors when Media Composer Soft and Pro Tools were at 
different rates (Item #116647) 
OS/Platform: All/HD 
Area: Video Satellite 
Previously if using Media Composer Soft (no hardware) as a Video Satellite, no errors were 
thrown about non-matching frame rates, even if the settings were incorrect. 
 
In some cases, Avid video or satellite track edits don't align properly with video clips 
in AAF sequence (Item #118252) 
OS/Platform: Mac, Windows/HD, LE 
Area: Video Satellite, Avid video peripherals 
In some cases, a satellite or Avid video track could incorrectly show edits that did not align with 
the original AAF sequence. 
 
With multiple Pro Tools systems connected via Satellite Link, Solo Clear on D-Control 
doesn't always properly update the solo state (Item #119376) 
OS/Platform: All/HD 
Area: Satellite Link, D-Control Multi-Mode 
With multiple Pro Tools|HD systems connected via Satellite Link and using D-Control Multi-Mode, 
if the Send/Receive Solos preferences are enabled, the solo state was not always updated 
properly after doing a Solo Clear from D-Control. Tracks on one of the system showed as muted 
when they should not be. 

 

Field Recorder Workflow 
 
Expanding to new tracks by individual regions always creates new tracks instead of 
re-using matching tracks from other regions (Item #104872) 
OS/Platform: All 
Area: Field Recorder Workflow 
When expanding field recorder files individually to new tracks by either channel name or number, 
Pro Tools will re-use the new tracks made by previous expansions, rather than creating new 
tracks every time, as happened in previous versions.
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When expanding tracks by channel name and/or number, the tape name should be 
ignored (Item #116432) 
OS/Platform: All 
Area: Field Recorder Workflows 
Previously when expanding alternate channels from a field recorder to new tracks, duplicate new 
tracks would be created for each sound roll. Now when expanding to new tracks, sound roll is 
ignored, so that if you expand out regions that come from multiple sound rolls, they only create 
one set of new tracks. 

 

Video 
 
QuickTime playback will shake or wobble within the floating video window. This 
occurs with multiple movie formats. (Item #106687) 
OS/Platform: All 
Area: QuickTime 
Previously certain QuickTime formats (including DV and Motion JPEG) would wobble when played 
in the QuickTime Window within Pro Tools. 
 
Video track frames view is lost after zooming during playback (Item #106601) 
OS/Platform: All 
Area: Video 
The display of video track frames could be lost after zooming during playback. The frames are 
now redrawn after stopping playback. 
 
Sync inconsistencies when using a Blackmagic DeckLink Extreme card with some 
Video Sync Offset settings (Item #112766)  
OS/Platform: Mac 
Area: QuickTime with Blackmagic Decklink Card 
Previously when playing some QuickTime movies through a Blackmagic Decklink Extreme with a 
Video Sync Offset of 0 frames, or any multiple of 4 frames, the video sync would occasionally 
jump by 1 frame for a few seconds before recovering. 
 
Bouncing a QuickTime Movie to disk with a selection beyond the end of a video region 
(Item #113197) 
OS/Platform: All 
Area: QuickTime, Bounce to Disk 
Attempting to bounce a QuickTime movie with a duration beyond the end of the movie could 
result in the bounce being truncated, as well as audio and video being out of sync.  
 
In a session with a QuickTime movie, when loop recording for any amount of time 
longer than the movie, the movie screen goes black after the first loop point (Item 
#113197) 
OS/Platform: All Mac 
Area: QuickTime 
Issue resolved when using loop playback in a session with a QuickTime movie. Previously, if the 
loop selection were longer than the movie, the movie would only play the first time through, each 
loop after that would just display a blank video screen. 
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Resizing a video window results in "white flashing” (Item #109939) 
OS/Platform: All 
Area: Video 
Previously when resizing the video window within Pro Tools, the window would flash white 
repeatedly during the resize. 
 
Stuttering QuickTime playback on Nehalem Mac Pros with GT120 Dual graphics card 
(Item #116481) 
OS/Platform: All Mac (Nehalem) 
Area: QuickTime 
Issue resolved whereby in certain situations, when playing QT movies on a second monitor from 
the GT120 graphics card in a Nehalem Mac Pro the output would drop frames and appear to 
stutter. 
 
Separate Region Operates on All Related Takes with QuickTime movies (Item 
#117087) 
OS/Platform: Mac/All 
Area: QuickTime 
Pro Tools could post an assertion error when doing a Separate Region on a QuickTime movie if 
the Preference "Separate Region Operates on All Related Takes" was enabled. 
 
Improved QuickTime performance when playing out Mojo SDI or Mojo (Item 
#117617) 
OS/Platform: Mac/HD, LE 
Area: QuickTime, Mojo SDI, Mojo 
Performance of QuickTime video playback out Avid Mojo SDI or Mojo on Mac has been optimized. 
 
Cannot down convert 720p movies with Blackmagic Decklink Extreme card (Item 
#118086) 
OS/Platform: Mac/All 
Area: Blackmagic DeckLink 
You can now down convert 720p movies with the Blackmagic DeckLink card using the DeckLink 
v7.x drivers. 
 
Crash on close or failure to calculate waveforms in some cases with QuickTime 
movies containing blank space (Item #118427) 
OS/Platform: Mac/All 
Area: QuickTime 
In some cases, a QuickTime movie bounced from Pro Tools containing blank space could cause 
Pro Tools to crash on session close, or cause waveforms not to be calculated properly, if that 
QuickTime movie was imported into another session. 
 
Selecting Fit to Screen on QuickTime movie doesn't work properly in all cases (Item 
#119032) 
OS/Platform: Mac/All 
Area: QuickTime 
At some resolutions on dual monitor systems, selecting Fit to Screen on a QuickTime movie 
would not properly position the movie on screen. This has been resolved. 
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Video out PCIe and Video out FW can now be saved (Item #119536) 
OS/Platform: Mac/HD, LE 
Area: Video, Avid Video Peripherals, Blackmagic 
In some cases, Video out PCIe and Video out FW were not saved. These settings are now saved 
with the session. 
 
Access Violation error after opening the video window on a system that does not have 
QuickTime installed (Item #119898) 
OS/Platform: Vista/All 
Area: Video, QuickTime 
On Windows Vista systems without QuickTime installed, Pro Tools would post an Access Violation 
error if a session containing a QuickTime video was open and trying to view the Video window. 
Although having QuickTime installed is required to use QuickTime video, this issue has been 
resolved. 

 

Interplay 
 
Importing a sequence from Interplay can result in the sequence being spotted at the 
wrong location when "Pro Tools Import Settings" are set in Interplay Administrator 
(Item #99612) 
OS/Platform: Windows XP/HD 
Area: Interplay  
In previous versions of Pro Tools, when "Pro Tools Import Settings" are set in the Interplay 
Administrator, and the "Time Code Mapping Options" is set to "Maintain Absolute Timecode" in 
the Import Session Data dialogue, a sequence would be opened at the incorrect timecode, if the 
session start time and sequence start time did not match. Now Interplay sequences will always 
spot to the correct timecode location. 

 

MIDI 
 
Playback of Reason 4 via Rewire often results in -9403, -9128 (Item #100612) 
OS/Platform: All 
Area: Rewire 
Often using Reason with a reasonably large Reason Song File connected to Pro Tools via Rewire 
would result in -9403 and -9128 errors. 
 
Trimming grouped MIDI regions (Item #117404) 
OS/Platform: All 
Area: MIDI 
Pro Tools could crash (Mac) or post an Access Violation (Windows) when trimming out a grouped 
MIDI region containing automation data. This has been resolved. 
 
MIDI editor zooming (Item #117919) 
OS/Platform: All 
Area: MIDI editor 
In some cases, zooming in the MIDI editor window was not functioning properly. This has been 
resolved.
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Hang after clicking in certain fields in the Score Setup window (Item #120105) 
OS/Platform: All 
Area: MIDI, Scoring 
After clicking in the Below Title and Composer or Below Chord Symbols or Diagrams fields, Pro 
Tools would post the dialog, "This field requires values in the range of 5.00 and 999.00." Clicking 
OK would not close the window and the only option was to force quit. 

 

Machine Control/Sync 
 
Record button is red instead of yellow when doing an Edit Preview with 
MachineControl (Item #120161) 
OS/Platform: Mac, Windows/HD 
Area: MachineControl 
When doing an Edit Preview with MachineControl, the record button in the transport window was 
red instead of yellow. 
 
Pro Tools incorrectly displays the text "Using Peripheral" under in the Session Setup 
Window>Time Code Settings (Item #119886) 
OS/Platform: Mac, Windows/HD 
Area: SYNC 
In the Session Setup Window>Time Code Settings under Freewheel, Pro Tools displayed the text 
"Using Peripheral" instead of "None". This has been resolved. 
 
The Session Setup window displayed settings for SYNC HD and SYNC I/O when no 
SYNC was connected (Item #119717) 
OS/Platform: Mac, Windows/HD 
Area: SYNC 
The Session Setup window displayed Ref Present, Locked, and Speed Cal in the UI when a SYNC 
was not connected. These elements should only be displayed when a SYNC HD or SYNC I/O is 
connected to the system. 
 
Added new shortcuts to enable/disable Remote Mode and Generate LTC (Item 
#119423) 
OS/Platform: Mac, Windows/HD 
Area: Sync, MachineControl 
The following keyboard shortcuts can now be used to enable/disable Remote Mode: 
Ctrl+Opt+Cmd+J (Mac) and Ctrl+Win+Alt+J (Windows). Additionally, ICON users can use the 9-
pin Remote button. The following shortcuts can now be used to enable/disable LTC Generating 
(GEN LTC): Ctrl+Cmd+J (Mac) and Ctrl+Win+J (Win). 
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DigiBase 
 
Digidesign databases now stored on system drive rather than on individual volumes 
(Item #117627) 
OS/Platform: All 
Area: Digibase 
Beginning in Pro Tools 8.0.3, Digidesign database files for each volume are now stored on the 
system drive, in the location: /Library/Application Support/Digidesign (on Mac), and C:\Program 
Files\Digidesign\Pro Tools\Databases (on PC). The benefits of this change are that Pro Tools will 
no longer write Digidesign database files on all mounted volumes, volumes can be ejected from 
the OS while Pro Tools is running, and it resolves potential corruption issues that could occur 
when changing read/write permissions on some shared storage systems. With this new behavior, 
in order to maintain a volume's index when moving a drive from one system to another, make a 
copy of the volume's Digidesign database file from the location mentioned above and place it in 
the same location on the second system before launching Pro Tools on the second system. 
Alternately, a volume's index can be re-created on the second Pro Tools system. Old Digidesign 
database files located at the root level of your volumes can be safely deleted with Pro Tools 
8.0.3, although users sharing hard drives with older Pro Tools systems may wish to keep the 
older Digidesign Database files. 
 
Digibase memory usage and performance enhancements (Item #119337) 
OS/Platform: All 
Area: Digibase 
Previously, Digibase could hold large chunks of memory when indexing, causing Pro Tools' 
memory usage to grow, and in some cases, causing Pro Tools to crash when indexing a large 
volume. Digibase is now more efficient with memory usage. Additionally, browsing indexed 
folders in Digibase is now faster. 

 

Performance/Usability 
 
Don't Show This Dialog again option (Item #119037) 
OS/Platform: All 
Area: Error dialogs, Preferences 
Pro Tools 8.0.3 adds a new "Don't Show This Again" option to some common error and warning 
dialogs. By checking this box in the error dialog, Pro Tools will no longer post that specific dialog 
or warning. Once checked, this setting is saved with the system. The list of dialogs which have 
been chosen can be cleared/reset at anytime in Setup>Preferences>Display by pressing the 
Reset button next to Reset "Don't Show This Again" Settings. 
 
Improved horizontal scrolling with track balls and Apple Mighty Mouse (Item 
#119003) 
OS/Platform: Mac/All 
Area: Scrolling 
Optimized scrolling speed and performance with track balls and Apple Mighty Mouse. The scroll 
speed is now more consistent with using the right/left arrow buttons in Pro Tools. 
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Pro Tools now takes less time to quit (Item #119915) 
OS/Platform: All 
Area: Quit 
Pro Tools now quits approximately 1 second faster than in previous releases. 
 
UI stuttering in the Edit window rulers when using Continuous Scrolling or Center 
Playhead when session contains any type of video track (Item #112234) 
OS/Platform: All 
Area: Scrolling 
Improved scrolling performance when working in either Continuous Scroll or Center Playhead 
scrolling mode. Previously if there was a video track in the session, either of these modes would 
cause GUI stuttering in the rulers and edit window. 
 
 The label for System Delay no longer exists in Pro Tools 8 (Item #113425) 
OS/Platform: All 
Area: Menus 
Since Pro Tools 8 the label for the overall system delay in the Session Setup window has not 
been labeled correctly. 
 
The Import Session Data window can now be resized (Item #118660) 
OS/Platform: All 
Area: Import Session Data 
The Import Session Data window can now be resized vertically. This is useful when importing 
sessions (or AAF sequences) containing large numbers of tracks. 

 

PRE 
 
Multiple repeated error dialogs thrown if PRE goes offline (Item #116224) 
OS/Platform: All 
Area: PRE 
If the PRE mic preamp goes offline, Pro Tools would post repeated error dialogs for each PRE 
unit every 20 seconds. A "Don't Show This Again" check box has been added to this dialog to 
keep it from repeatedly appearing if desired. 

 

 Plug­ins 
 
Opt click and opt shift click does not work on the "TDM to RTAS" "RTAS to TDM" drop 
down menu in the plug-in window (Item #106687) 
OS/Platform: All HD 
Area: Plug-ins 
Unlike previous versions of Pro Tools, now when Option (Mac)/Alt (Windows) or Option+Shift 
(Mac)/ Alt + Shift (Windows) clicking to change a plug-in from TDM to RTAS or vice-versa, the 
"do to all' and 'do to selected" commands work correctly. 
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Custom "Processing" text in AudioSuite plug-ins is not displayed properly (Item 
#112995) 
OS/Platform: All 
Area: AudioSuite 
Certain Audiosuite Plug-Ins that use custom text in the "Processing" dialogue were not displaying 
correctly when processing audio. In some cases this also meant that the time remaining was also 
not displayed correctly. 
 
Pro Tools crashes on launch with certain Bomb Factory Plug-ins installed (Item 
#115836) 
OS/Platform: All  
Area: Plug-ins 
Issue resolved whereby in certain situations Pro Tools would crash on launch if a plug-in was 
installed but a valid ilok authorization was not found. 
 
AIR Talkbox does not pass the audio integrity test when attempting to phase cancel 
two instances (Item #116266) 
OS/Platform: All  
Area: AIR Plug-ins 
In some situations, passing the same audio through two AIR Talkboxes on separate tracks and 
then phase reversing one of the tracks did not result in complete phase cancellation, and some 
audio was still heard. 
 
Automation enabling the "level" fader on Part D of Xpand2 will not show an 
automation light unless Part C's "level" fader is also automation enabled (Item 
#116494) 
OS/Platform: All 
Area: XPand2! 
Previously when putting Part D Level into automation enable mode, the automation light next to 
the fader would not light up, unless Part C level was also automation enabled. 
 
Reel Tape Flanger and Delay stop passing audio when EQ3 is instantiated (Item 
#117417) 
OS/Platform: All 
Area: Plug-ins 
Resolved an issue in which Reel Tape Flanger would stop passing audio, or Reel Tape Delay 
would stop passing wet signal, after instantiating an EQ3 plug-in. 

 

3rd Party Compatibility 
 
Pro Tools does not launch with Internet Explorer 8 Installed (Item #114343) 
OS/Platform: All Windows 
Area: Compatibility  
An incompatibility between Pro Tools and Internet Explorer 8 has been fixed. Pro Tools 8.0.3 will 
now launch if IE 8 is installed. The following plug-ins are still incompatible with IE 8, and Pro 
Tools will not launch if they are installed: Structure, Structure LE, Strike, Velvet, and Hybrid. We 
are working to address this issue in a future plug-in release. Please visit 
http://www.digidesign.com/air for updates. Additionally, some 3rd party plug-ins may also be 
incompatible with IE8. Please contact individual plug-in manufacturers for more information.
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Crash on launch with Quantum StorNext SAN (Item #116771) 
OS/Platform: Mac/HD 
Area: Compatibility 
Previously if the Pro Tools CPU were connected to a Quantum StorNext SAN, Pro Tools would not 
launch. 
 
AAF's created in Quantel editing systems (Item #117858) 
OS/Platform: All/HD, LE 
Area: DigiTranslator 
AAF’s created in a Quantel editing system could import into Pro Tools incorrectly with regions 
placed at the wrong time code location, incorrect region lengths, or with missing fades. This issue 
has been resolved. Please note that only AAF’s with mono audio files can be imported. Stereo 
interleaved Quantel AAF’s will not import, or will import the left channel only. 

 

Miscellaneous 
 
Using Export Regions as Files to a networked (transfer) drive, you can only export the 
same file once (Item #105356) 
OS/Platform: All 
Area: Session/File Management 
Previously when exporting regions as files to a network drive set to Transfer only, it was only 
possible to export a file once. Attempting to re-export the same region would always fail. 
 
When hitting play in PT, the cursor will jump earlier in the timeline then "catch up" to 
the actual cursor position before audio starts playing (Item #109958) 
OS/Platform: All 
Area: Playback 
Previously, when hitting play, Pro Tools would jump back in the timeline by the amount of the 
hardware buffer size, then catch-up with itself before actually playing any audio. This behavior 
has now been changed so that the cursor does not move from its position on the timeline when 
play is pressed. 
 
When locking regions in a region group, locking regions behavior is not working 
correctly (Item #113377) 
OS/Platform: All  
Area: Region Groups 
Previously if a region group was locked, it was not possible to unlock it without ungrouping it. 
Locking and unlocking region groups now works as designed. 
 
When a selection contains tracks in playlist view and an aux track, pasting crashes 
Pro Tools (Item #113576) 
OS/Platform: Mac All  
Area: Playlists 
Issue resolved where Pro Tools would crash in certain situations when copying and pasting in 
playlist view. 
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Channel Matrix doesn't work correctly with Pro Control under Pro Tools 8 (Item # 
115111) 
OS/Platform: All/HD 
Area: Pro Control 
In certain situations with Pro Tools 8 and above the channel matrix on Pro Control would not 
work correctly when selecting, soloing and muting tracks. 
 
If you suspend groups then save the session and re-open the session, the groups are 
no longer suspended (Item #115349) 
OS/Platform: All 
Area: Session Management 
Issue resolved where if groups were suspended in a session, the session saved, closed and re-
opened, the suspended groups would no longer be suspended. 
 
Can't go online when in Loop Play mode (Item #117407) 
OS/Platform: All/HD 
Area: Loop play, online 
Pro Tools HD could not go online when in Loop Play mode. This has been resolved. 
 
Clearing audio regions after selecting Expand Alternates to New Tracks (Item 
#117415) 
OS/Platform: All 
Area: Expand Alternates to New Tracks 
In some cases, clearing audio regions from a session could cause Pro Tools to crash after right 
clicking on regions and selecting Expand Alternates to New Tracks. 
 
Zoom toggle and track heights (Item #117443) 
OS/Platform: All 
Area: Zoom Toggle 
After using Zoom Toggle, changing the track height of one track was adjusting all tracks, making 
it appear as if a Group was enabled. This no longer occurs. 
 
Pro Tools could become unresponsive when relinking offline fades (Item #117641) 
OS/Platform: Mac, All 
Area: Relinking, Fades 
In some cases, Pro Tools could become unresponsive for long periods of time when relinking 
sessions containing many offline fades and selecting "Regenerate missing fades without 
searching". This has been resolved. 
 
Bounce to Disk or Bounce to QuickTime Movie default settings (Item #117681) 
OS/Platform: All 
Area: Bounce to Disk 
Bounce to Disk now saves the sample rate, bit depth, file type, and save destination settings with 
the session. New sessions will default to the session's settings. If any changes are made, they 
are remembered with the session. 
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Memory Locations containing VCA tracks (Item #117855) 
OS/Platform: All/LE 
Area: Memory Locations, VCA tracks 
On Pro Tools LE, when using a session containing VCA tracks which was created on a Pro Tools 
HD system, Pro Tools LE posts the dialog "Group Master Tracks Cannot be Shown" when 
selecting a memory location which contains VCA tracks. While this dialog is correct, the dialog 
would appear multiple times if the memory location contained multiple VCA tracks. This dialog 
now includes a "Don't Show This Dialog Again" option. Choosing the "Don't Show This Again" box 
and selecting OK in the dialog will prevent this dialog from appearing in the future. The "Don't 
Show this Again" dialog status can be reset from Preferences>Display. 
 
At higher sample rates, recording could stop prematurely if the Open Ended Record 
Allocation preference was set (Item #117927) 
OS/Platform: All 
Area: Open Ended Record Allocation 
At 88.2 kHz and higher, recording could stop prematurely at half of what the Open Ended Record 
Allocation preference was set to. For example, if the preference were set to 30 minutes, a record 
pass would stop after only 15 minutes. This issue has been resolved. 
 
Move Song Start dialog does not display Time Code or Feet + Frames with DV Toolkit 
2 or Complete Production Toolkit (Item #117938) 
OS/Platform: All/LE 
Area: DV Toolkit 2, Complete Production Toolkit 
Pro Tools LE with DV Toolkit 2 or Complete Production Toolkit now shows Time Code and Feet + 
Frames in the Move Song Start dialog. 
 
RTAS plug-in automation accuracy varies depending on HW buffer size (Item 
#118478) 
OS/Platform: All 
Area: Automation 
RTAS plug-in automation now takes the HW buffer size into account, and is now more consistent 
across various HW buffer sizes. 
 
With 002/003, Core Audio Manager would always default to 48kHz after setting it to 
44.1kHz and closing the Core Audio Manager. This would cause unpredictable results 
with 3rd party applications. 88.2kHz/96kHz were not affected. (Item #119266) 
OS/Platform: Mac/LE 
Area: Core Audio 
With 002/003 family interfaces, Core Audio Manager would always default to 48kHz after setting 
it to 44.1kHz and closing the Core Audio Manager. This would cause unpredictable results with 
3rd party applications. 88.2kHz/96kHz were not affected. 
 
Pro Tools could crash after using the Shift+S shortcut to solo (Item #120253) 
OS/Platform: All 
Area: Solo 
Resolved an issue in which Pro Tools could crash after using the Shift+S keyboard shortcut to 
repeatedly solo/un-solo a track. 
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